Date: fé,//fé (07

Initials:
N
Department of Forensic Biol
Condom Trace Evidence A@@s Manual
Verfb?&
N
N
R\~
N\
&

Condom Trace Evidence Analysis Manual v, 1.0 Fune 17, 2003



Initials: £ L

14

Condom Trace Evidence Analysis Manual v. 1.0 Tune 17, 2003 Page 2



Initials: /\’}g{ Date: 1 ¢ f (e (o7

Vs /

Table of Contents

L Detection of Polydimethylsiloxane (PDMS) by Fourier Transform Infrared Spectrometry (FT-IR)

......................................................................... 4
A General guidelines . .. .. ... ... ... 4
B. Analysis by Fourier Transform infrared spectrometry . ......................... 5

1 SEArt-UD . . . 5

a. Startup of system, OMNIC E.S P. software, and diagnostics check
.................................. \5

b. Experimentsetup .. ................ & ................. 6

c. Verification of collection parameter: Q ...................... 7

2. Collectionof spectra . ... ......... NN ... ... . 9
a. Removing and placin, @ inthe sample holder . . ... .......... 9

b. Collection of the Pafk®rOund spectrum . . ... .................... 9

c. Collectiogo\ég(ra fromblankIRcards . ....... ... .. ...... ... 10
ion

d. Prepa f extraction negative (methylene chloride blank), positive o
co dsampleextracts . . ....... ... ... ... .
€. ‘Qg%tion of samples onto IR samplecards . . ............. .. .. .13
{C) Collection of control and sample spectra . . .. .................. .14
?E Labeling and storage of IR cards .. ............. ... ........ .15
h. Storage of spectraldata . ... ... ... ... ... ... ... ... .. ... .. B )
3 Analysisof spectra . .. ... ... ... .. ... ... . 16
a. Standard PDMS spectrum ... .. ... ... 17
b. Subtractionof spectra . ... ... ... ... ... .18
c. Librarysearch .. ... ... ... . . . . . . ... ... .19

Condom Trace Evidence Analysis Manual v, 1.0 June 17, 2003 Pagel



Initials: ;fwii;f; Date: [0 [ (¢ L%/

d. Printing sample spectra and standard PDMS spectra . .......... .. 21
4. Interpretation of spectra . .. ......... ... ... 22
a. General guidelines .. ........... ... ... ... i 22
5. Troubleshooting . .. ... .. ... ... ... . i 23

Characteristic Infrared Absorptions of Various Functional Groups . .. 24

C. Laboratory repOrtS . . ... ... .. 25

D. References .. ........ ... ... . i N & Y 26
N
>

Condom Trace Evidence Analysis Manualv. 1.0 Jane 17, 2003 Page 4



Initials:

L

g | o lie (o7
. Date: (° [ (k97

Detection of Polydimethylsiloxane (PDMS) by Fourier Transform Infrared
Spectrometry (FT-IR)

A. General guidelines

All reagents are available pre-made and quality control checked. Do not use supplies that
have not been quality control checked.

In general, semen analysis (AP, sperm identification, or p30 ELISA) is done prior to lubricant
analysis. The analysis of amylase and other body fluids should also precede lubricant analysis.

Scissors and other cutting instruments must be cleaned with 10% bigach followed by 70%
ethanol and dried before each cutting of a swab, including blanks. ‘%nust not contact any
“greasy” or silicone-based lubricants before sampling the sw lean scissors between
samples. New razor and scalpel blades must not be used \@ first being cleaned as they

may be coated with a lubricant. @

of a W?b. These adhesives may produce an
hat can interfere with the spectrum of
Femoving a portion of the cotton material,

An adhesive is used to attach cotton to the stick
infrared spectrum, even at low concentratiggs,
polydimethylsiloxane (PDMS). Therefore %
do not contact the stick with the scisso ‘

To reduce the amount of purge t1m equired to reduce the absorption peaks due to carbon
dioxide and ambient mmsture reathe into the sample compartment when changing
samples. Use the compartm dow when possible and make sample changes quickly.

Negative controls are ;&sary to detect any interfering peaks from the extraction
solvent, scissors, § nd/or any other extraneous contaminants.

Perform ALL ylene chloride extractions under an operating chemical fume hood,
not a bioh hood.
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B. Analysis by Fourier Transform infrared spectrometry

1. Start-up

a. Startup of system, OMNIC E.S.P. software, and diagnostics
check

NOTE: The procedure assumes some knowledge of the Windows® operating system.

1. NOTE: The IR bench is left on at all times to maintain stability within the instrument
and eliminate warm-up. Turn on the computer and monitor. Check that the Nicolet
Magna-IR 550 Series II bench is turned on and ready to collect speﬂa he Power indicator

light, at the top front left of the instrument, should be lit. If the indj ight is not lit, check
the power switch at the rear of the instrument and the po, ord to ensure that the

connections are intact. Q
2. A prompt for the network connection appears. Eu&ogin name and password.
3. Double click the OMNIC E.S.P. icon on the @ter desktop.
4. Click the Collect option on the menu Q
o

This verifies that the comporhgts 8f the instrument are operating properly. If there are any
components with a red sla@ ugh it, refer to the Troubleshooting section.

5. Click on Advanced Diagnostic

*

6. Click the Report * Click the View More button. Click the Print button. Click the
Return button tvs lick the close window button at the top right of the window.

Store this re@m the F'T-IR Instrument Usage Log, Maintenance, & Diagnostics Records
binder under ¥he Diagnostics section.
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b. Experiment setup
1. In the Experiment title bar, which is just above the toolbar, make sure Lubricants Analysis

method is selected.

2. In the F71-IR Instrument Usage Log, Maintenance, & Diagnostics Records binder under the
Usage Log section, enter the date, instrument start time, purpose of usage, and your initials.

NOTE: Remember to fill in the 7ime Ended column when finished with the system along
with any comments concerning the instrument’s operation.

[
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c. Verification of collection parameters

1. To verify that the collection settings are correct, click the Collect option on the toolbar and
select Experiment Setup.... The following list contains the parameter settings for the
collection of spectra. Compare each value with those listed below.

Collect
No. of Scans: 32
Resolution: 2
Data spacing: 0.482cm’™
Final format: Absorbance
Correction: None

O Automatic atmospheric correction @\%

O Preview data collection 0
File Handling ¢ Save interferograms
Background Handling ® Collect background ﬂ&ninutes

Bench é

Gain: Autogain
Q2

Velocity: 0.6329

Aperture: 69 (LQ

@ Min/Max
Sample Compartment: Main K
Detector: DTGS KBr s\o
Beamsplitter: KBr
Source: IR 6

Window material:
Spectral Range
Saved: @,0-400

O Single be%
O Tone

Accessory: None @
X
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Quality
Select View: @ Spectrum
Sensitivity
¢ Use spectral quality checks
¢ Spectrum checks
O Peaks present
¢ Totally absorbing peaks 50
¢ Fringes or channeling 5
O Derivative peaks N/A
#Baseline error 5
& CO2 levels 50
#H20 levels 70

N
Advanced 0®

Zerofilling: 1 Level

Apodization: Happ-Genzel @
Phase correction: Mertz

O Single-sided interferogram @

00 Reset bench at start of collection

Diagnostics
The printout from Advanced %gnostics provides the necessary information
needed to determine that all stems are running properly.
2. If the settings are correct, t sS?ware is ready to collect spectra. Proceed to the section
Collection of spectra.

AQ’
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A background spectrum should be collected every ten (10

A Date:
2. Collection of spectra
a. Removing and placing IR cards in the sample holder

On either side of the sample chamber are two levers. Flip them up.

Open the window to the sample chamber by sliding the cover toward the back of the
instrument and remove or place any IR cards in the sample holder.

Close the window by sliding the cover toward the front of the instrument. Flip both levers
down.

NOTE: The levers are kept in the raised position when the cov?ywn so that the purge
is maintained in the rest of the instrument.

b. Collection of the background sqﬁ

€8 Or as necessary. Certain actions

on the part of the analyst may require the collection ground spectra more frequently.

L.

The sample chamber should be empty. ﬁ, remove any IR cards in the sample chamber
following the instructions in the sectioh Removing and placing IR cards in the sample

holder.
Click the Col Bkg (Collect %?(}ound) button on the toolbar.

A Confirmation windo zﬂears. It reads:

Backg d
Pl prepare to collect the background spectrum
Click OK. &

A Confirmation window appears after the background has been collected. It reads:
Data collection has stopped.
Add to Window 17?

Click No.
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c. Collection of spectra from blank IR cards

This section describes the collection of spectra from the IR cards before application of the samples.
These negative controls show that the IR cards do not contribute to the PDMS spectrum. Every IR
card is checked before sample application! Discard any cards that contain detectable

contaminants!

1. Place a blank IR card (3M Type 61 polyethylene) into the chamber following the instructions
in the section Removing and placing IR cards in the sample holder.

2. Click the Col Smp (Collect Sample) button on the toolbar.

3. The Collect Sample window appears. It reads: @\bg
Enter spectrum title: 0

4. For the spectrum title, type: card - blank. Click O @Q

5. A Confirmation window appears which reads:

Sample (b
Please prepare to colleample spectrum.

Click OK.

6. A Confirmation window appears & the spectrum has been collected. It reads:
Data collectio topped.

Add to Win@ :
Click Yes. @
7. CHECK THE BE{&ARD SPECTRUM FOR CONTAMINANTS.
The spectrum 9{&1& appear similar to Figure 1 on the following page.

8. Change the dgplay limits by selecting Display Limits... in the View menu and set the X-Axis
Limits from a Start: value of 1300 to an End: value of 700. Click OK.

9. Click on the View menu and select Full Scale.

10.  The spectrum (1300-700cm™) should appear similar to the spectrum on the following page.
The two peaks between 750-700cm™ are from polyethylene.

If similar, remove the IR card and continue to step 11.

If there are any other peaks, remove the card and discard it. Start at step 1 with a new card.
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11.  Removethe blank card from the sample chamber. Store the IR card in a clean, dry place until
the sample is ready to be applied to the card.

12.  Select the spectrum card - blank from the list. Once the spectrum title is highlighted, press
the Cut button on the toolbar.

13.  Repeat steps 1-12 until all the blank cards have been checked for contaminants (change the
Display Limits back to 4000-400cm™).

50{
454
4.0+
35

304

Absorbance

Absorhance

004
062
-0.60 _M
1300 o T 1000 900 803

Wavenumibers {om-1}

Figure 1b: Spectrum of polyethylene IR card in the 1300-700cm region.
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d. Preparation of extraction negative (methylene chloride blank),
positive control, and sample extracts

The purpose of the extraction negative control (reagent blank) is to verify that the solvent does not
contain any infrared active species that may interfere with the detection of PDMS. The purpose of
the positive control is to demonstrate the effectiveness of the extraction.

L2

NOTE: These steps MUST be performed under a chemical fume hood.
Prepare an extraction negative tube by labeling an empty 1.5mL microcentrifuge tube as such.

Obtain a positive control tube and note the lot number on the ew worksheet.

With a fine tipped marker, label each checked, blank IR ca: the appropriate identifier

(extraction negative, positive control, or sample ide ti% B number and swab type)).
Check off the appropriate box on extraction works@

NOTE: Each card must contain the date % it was prepared and the initials of the
individual preparing the cards. Q

Place all tubes in the order listed on the(%action worksheet.

Place the IR sample cards in the rder as the tubes. Have a witness check the tubes and
cards and initial the extractiotwo sheet.

Pipet approximately §ra@nethylene chloride into a labeled, working stock tube.
NOTE: WhenevaNpipetting methylene chloride, the pipet tip must be “conditioned” by
pipetting the S;S p and down about 5-10 times before dispensing. Ifthis is not done, the

methylene cRIpsgte will leak out of the tip immediately.

Pipet 75uL of methylene chloride into each tube. Ensure that the entire sample is covered
in solvent. Close each tube tightly to minimize evaporation.

Mark the level of the meniscus on the side of each tube with a fine tipped marker.
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e. Deposition of samples onto IR sample cards
NOTE: This MUST be performed under a chemical fume hood.

1. Place each IR sample card onto an elevated surface, ensuring that the membrane does not
touch any other surface or solution.

2. Vortex the appropriate sample tube for 15 seconds.

NOTE: Check the meniscus of the PDMS standards to ensure that the solvent levels are not
lower than were previously marked. Add sufficient methylene chloride to raise the level to
the previously marked meniscus for samples that have experience\ nt loss. Vortex the
affected sample tube(s) for 15 seconds. @

extract and place onto the
other 3-5uL of the extract and
nt to dry. Repeat until all of the
card labeled for samples and blanks.

3. With a pipet and an aerosol resistant tip (ART), take 3-5u
center of a labeled IR card. Allow the solvent to dry.
place onto the same part of the IR card. Allow
extract has been delivered to the card. Repeat for e

NOTE: It is important that most of the is concentrated at the center of the IR card
window because the infrared beam pa ugh near the center (adjacent to the red laser
beam). This area must contain a significipt amount of the sample for an accurate spectrum
to be collected.

evaporate. Once dry, the es are ready for IR analysis.
. \A

?S

4. After the methylene chlorgﬁs&vaporated, wait 10 minutes to allow residual moisture to
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f. Collection of control and sample spectra

Collect a new background spectrum. The background level should be checked every ten
minutes, or more frequently, if required.

Begin to collect spectra for each card. Follow the instructions in the section Removing and
placing IR cards in the sample holder.

Place an IR card with a sample into the chamber.
Click the Col Smp (Collect Sample) button on the toolbar.

The Collect Sample window appears. It reads: @\bg
Enter spectrum title: 0

For the spectrum title, enter the sample identifier a: i@lrs on the IR card and the

worksheet. Click OK.

A Confirmation window appears which rea (b

Sample
Please prepare to col sample spectrum.
Click OK.

A Confirmation window appea‘@r the spectrum has been collected. It reads:
h

Data collecti s stopped.
Add to Wi 17?
Click Yes. . A

Remove the IR c@m the sample chamber and place the next IR sample card into the

chamber. &
Repeat samplg collection steps 4-8 for all sample cards.

After collecting spectra for all sample cards, the spectra should be baseline corrected. For the
Automatic Baseline Correction function to baseline correct the entire spectrum, the X-Axis
Limits (i.e., wavenumbers) must extend from 4000-400cm™ . If the X-Axis Limits are not
from 4000-400cm, then select Display Limits... in the View menu and enter 4000 as the
Start: value and 400 as the End: value.

NOTE: Automatic baseline correction must be performed with the spectrum displayed as an
Absorbance spectrum.
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11.

12.

13.

14.

15.
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From the Edit menu, choose Select All. All the spectra should now be displayed in red.
Click on Process on the menu bar and select Automatic Baseline Correct.

Spectra that have been baseline corrected have an asterisk (*) preceding the name of the
spectrum.

The original uncorrected spectra should be deleted from the window by using the select and
cut method. Click on the down arrow to the right of the sample name window. A pull-down
list of all the spectra in the window will be displayed. Click on each name and cut each one
(scissor function) that is not baseline corrected (spectra without asterisks).

Save the baseline corrected spectrum: @\9
a. Click on File and select Open....
b. Click the button Create New Folder an e it with the appropriate
extraction set date and time. Click off th er.
C. Close the Open window. §
d. Select all of the baseline corrected spesfTa to save into the folder. From the

Edit menu, choose Select Al the spectra should be displayed in red.

Click on File and select S

e. Open the extraction set or the appropriate extraction. Name the file
with the extraction date angstime and click Save. Close the Open window.
Proceed with the labeling and s of IR cards.

Continue with the Analys@pectra section.
. *
g AN

eling and storage of IR cards

and date on Welt the IR card was prepared. This envelope is used to store the IR card after

On the outside ﬁg—%oin envelope, print the case number, type of sample, analyst’s initials,
the spectrum has been collected.

Seal the envelope with tape and initial and date the seal.

Store the sample card in a secure place at room temperature.
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h. Storage of spectral data

The following printouts (hard copies) must be kept with each case file:
- positive PDMS control
- extraction negative
- all casework samples

Digital archives (computer) can be deleted after the case file has been reviewed AND after a period
of six months after the arrival of the evidence in the laboratory.

3. Analysis of spectra

The purpose of the analysis is to provide results concerning the identity o %ompounds detected
in casework samples. The analysis includes overlaying the sample and standard spectra and
performing spectral subtraction and library searches, if needed. Q

In order to analyze one spectrum at a time, each spectrum wjll ed to its own analysis window.
1. Highlight the spectrum to be analyzed by openj sample name window (down arrow to
the right of the sample name) and clicking ame of the selected spectrum.

2. Using the “cut” function (scissor icon),(cb e selected spectrum.

N

3. Move the spectrum to a new &;@w by clicking on the Window menu. Select New
Window. Name the new wintipw With the appropriate sample identifier. Click OK. A blank
window should appear. @

4. Hit “Paste.” The selé@spectrum should appear in the window.
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a. Standard PDMS spectrum

The spectrum of PDMS should appear similar to the spectrum below. There should be four peaks
that are around 1262, 1096, 1020, and 801cm™.

55
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Figure 2a: Spectrum of PDMS in the 400
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Figure 2b: Spectrum of PDMS in the 1300-700cm’ region.
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b. Subtraction of spectra

Overlapping peaks are possible. Absorption bands that are partially overlapped may appear as a
broad band with two maxima or with a principal maximum and smaller second maximum on either
face of the principal peak. Frequently, overlapping peaks appear as an absorption band with a
shoulder.

One spectrum may be subtracted from another in instances where an interfering component may be
present in a sample. The spectrum of the interfering component is subtracted from the sample
spectrum with a normalizing factor which is user defined. For example, if a sample spectrum contains
the cotton swab glue and the lubricant PDMS then the spectral features that arise from this glue can
be removed to reveal PDMS more clearly. Spectral subtraction must be K@vith BOTH spectra
in absorbance format. @

1. Retrieve the suspected interfering component spectrum frm@)rary. From the Analyze
menu, select Library Manager.... @

2. Click on Search Libraries. Click on PDMS sg.%m&

3. Select the standard spectrum (previously tandard spectrum with the highest match
value) and click the Add to Window b

4. Inthe Add to Window window, S@Add to Window1 and click the Add button. Close
the Library Manager window.

5. From the Edit menu, sele éect All. This will select all of the spectra present in the
window. As an alterga@ress Ctrl+W.
6. Press the Absorb&button to convert the sample spectrum to an absorbance scale.

7. Change the % limits to 1400-750cm™ by selecting Display Limits. .. in the View menu,
and set the X-Axis Limits from a Start: value of 1400 to an End: value of 750. Click OK.

NOTE: Ifthe interfering component is glue from a cotton swab, there may be an absorption
peak at approximately 1373cm™. This peak can be utilized as a reference peak in the
subtraction process. This peak is NOT unique to cotton swab glue, however, its absence in
a PDMS spectrum makes it a practical reference peak.

8. Click the Full Scale button.

9. From the Process menu, select Subtract....
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Ensure that the sample spectrum is the top spectrum in the window. Ifnot, click the double-
headed arrow button at the right to swap the spectra.

Adjust the Factor bar by sliding the button up or down the scale until the reference peak at
1373cm™ disappears (or flattens). The Coarser and Finer buttons can be used to
increase/decrease the normalizing factor.

Once the interfering component has been removed from the sample spectrum, add the
spectrum to a new window. Select the Add to new window and click the Add button.

A New Window window appears which reads:
Enter a title for the window: \%

For the title of the new window, type Subtraction result. & OK. The subtracted
spectrum will appear in a new window. Q

Proceed to the section Printing sample spectra al@@m PDMS spectra to print the

subtracted spectrum.

c. Library search

Perform a library search on those spectra that agkr to contain only trace amounts of PDMS or do
not resemble PDMS (no library search iSé&Jired for spectra that resemble the positive PDMS

control spectra): s\

1.

Make sure that the display@are set for 1300-750cm™. If not, change the display limits

by selecting Display Li ). in the View menu, and set the X-Axis Limits from a Start:
value of 1300 to z{l&aﬂue of 750. Click OK.

Click the Full @ button.
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Select the Library Setup... option in the Analyze menu. A Library Setup window appears.

In the Search Libraries folder, select the Sample Libraries from the list of Available
search libraries and groups: and then click the Add button.

NOTE: Ensure that the PDMS Standards Library is searched.
In the Extended Search folder, the Use extended search box should NOT be checked.

In the Search Results folder, the Configure search results button should be checked and
the Search type: box, Correlation should be selected.

Inthe QC Libraries folder, no libraries should appear under the Q%@aries and groups:.
In the Search Regions folder, the Use spectral regions ‘@should be checked. Input
the values 1300 under the Start column and 750 u % d column. A shaded area
should appear in the displayed spectrum correspondy e selected area.

Click OK.

Click the Search button. A display of esults in the 1300-750cm™ range will appear.
The display will include a list of the top matches based on the match value for each
compound and a spectrum for the hree matches.

NOTE: Search compares t seﬁted library spectra to that of the unknown spectrum and
displays the spectra that sely match the unknown.

Compare every spﬁ search result) whose match value is >80 to the sample spectrum.
If a PDMS spect arch result) is listed with a match value of >80, the sample may
contain PDM e a note of any PDMS spectra that yield a match value of >80 to the
sample. Do?&rmt the search results.

NOTE: Library search results may assist in preliminarily identifying trace amounts of PDMS
or other unknown compounds. Ifa preliminary identification is made, a known standard must
be run and compared directly with the unknown spectrum. No definite conclusions can be
drawn from a library search alone.

Click the Close button.
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d. Printing sample spectra and standard PDMS spectra

All casework sample spectra MUST be printed for every case file. Additionally, a standard PDMS
spectrum (positive control) and extraction negative control MUST be printed for every case file.

1. Press the % Transmittance button to convert the sample spectrum to a transmittance scale.

2. Place the cursor in the title bar and remove the asterisk in front of the sample title by deleting
it (an asterisk indicates that the sample has been baseline corrected).

3. From the Report menu, select Preview/Print Report....

4, Press the Print button and click OK.. @\%
5. From the Analyze menu, select Library Manager.... Qo

6. Click on Search Libraries. Click on PDMS sta @

7. Select the standard spectrum (previously notgd®stagdard spectrum with the highest match
value) and click the Add to Window buttQ

8. In the Add to Window window, select to a new window and click the Add button.

9. A New Window window appeéx ch reads:
Enter a title 6 window:

10.  For the title of the new w , type the title of the selected standard spectrum exactly as it

appears in the Libra ager window. Click OK.

11.  The spectrum Qﬂpear in a new window. Press the % Transmittance button to convert
the standard S spectrum to a transmittance scale.

12.  From the Report menu, select Print/Preview Report....

13.  Press the Print button and click OK..

14.  Return to Window 1 and analyze the next spectrum.

15. When finished with all samples, fill in the 7ime Ended column of the F7-IR Instrument Usage
Log.
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4. Interpretation of spectra
a. General guidelines
1. Each peak represents absorption of infrared energy by a molecular bond or functional group

(see table of Characteristic Infrared Absorptions of Various Functional Groups).
2. The peak area is related to the concentration of the IR active species.

3. The degree of peak broadening is determined by a combination of the following factors:

- instrument resolution
- different vibrational energy states of a molecular bond %
- intermolecular and intramolecular interactions @\

4. The extraction negative spectrum should appear similar to @ la and 1b. If additional

peaks are present, the methylene chloride has been contagfiqdted and the extracted samples
must be discarded. Each sample must be re-cut ang t through the extraction process
de

again using fresh quality control checked methylegne ri

S. The positive control spectrum must be ¢ to the spectra in the PDMS Standards
Library and it should appear similar to ?{}. e archived PDMS standards (and Figures 2a

and 2b). The spectrum must possess the fgur characteristic peaks in the fingerprint region
that are around 1262, 1096, 1020, 801cm™ and the rest of the spectrum must appear
similar. Ifthe positive control sp&@n does not appear similar to any of the archived PDMS

st be discarded. Each sample must be re-cut and taken

standards, the extracted sampies
through the extraction prog gain using fresh quality control checked PDMS positive

control. !
*

6. Sample spectra th@ear similar to the PDMS positive control spectrum (and Figures 2a
and 2b) likely c‘ il PDMS. The spectrum must possess the four characteristic peaks in the
fingerprint r% hat are around 1262, 1096, 1020, and 801cm™ and the rest of the spectrum
must appear symilar.

7. Sample spectra that appear similar to the extraction negative spectrum (Figures 1a and 1b)
can be considered negative for the presence of PDMS. However, the absence of

characteristic peaks does not mean that the compound is not in the sample. An appropriate
description of a negative result is “the compound was not detected.”

8. Sample spectra that appear similar to the PDMS positive control spectrum (with the four
characteristic absorption peaks) yet possess additional absorption peaks are indicative of a
mixture. Mixtures MUST be interpreted with caution.

o]
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9. Sample spectra that do not resemble the PDMS positive control spectrum nor the extraction
negative spectrum yet possess absorption peaks indicate that some chemical compound(s) is
(are) present in the sample. The library search may assist in a preliminary identification of the

compound(s).
5. Troubleshooting

For simple troubleshooting of the spectrometer and software, follow the instructions outlined below.

1. Click on Help and select Spectrometer Help Topics.
2. Double click on Troubleshooting. \%
3. Search this section for the problem and solution. &

For problems that are beyond the scope of the analyst, contgc rmo Nicolet and schedule an
appointment with a Field Service representative. @

Condom Trace Evidence Analysis Manualv. 1.0 June 17, 2003 Page 24



5
FTE
47 ¢

Initials: £ (] Date: ¢c /(e (o}

Characteristic Infrared Absorptions of Various Functional Groups

Functional Group Frequency Range (cm™) Intensity
C~H (alkyl) 2853-2962 medium-strong
=C-~H (alkenyl) 3010-3095 medium
=C~H (alkynyl) ~3300 strong
C=C 1620-1680 variable
C=C 2100-2260 variablg__
- CH(CH,), 1365-1370, 1380-1385 str ‘Q)ng
- C(CH,), ~1365, 1385-1395 \s}: , medium
R-CH=CH, 905-920, 985-1000 o \ \trong, strong
R,C=CH, 880-900 ) \ strong
cis-RCH=CHR 675-730 O N strong
trans-RCH=CHR 960-975 AQJ strong
O-H (alcohols and phenols, dilute 359063&\) variable and sharp

O-H (carboxylic acids, H bonded) 00-3000 variable and broad

solutions) K
O-H (alcohols and phenols, H bonded) @)-3550 strong and broad
O

C=0 (aldehydes) @ 1690-1780 strong
\k

C=0 (ketones) \Q 1680-1750 strong

C=0 (esters) ) 1735-1750 strong

C=0 (carboxylic acidv 1710-1780 strong

C=0 (amides) v 1630-1690 strong
Aromatic-H ~3030 variable

-N-H 3300-3500 (one peak) medium

-N-H, 3300-3500 (two peaks) medium

C=N 2220-2260 medium

Si~H 2100-2360 strong

Si-OR 1000-1100 strong and broad

=3
o
()
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Si-CH, 1250+10 strong and sharp
C. Laboratory reports

Refer to the Case Management Manual for the general guidelines for writing laboratory reports. The
template reports contain many pre-written sentences to guide explanations and interpretations of

results.
1. For the majority of cases, the following type of summary is sufficient:
a. Polydimethylsiloxane (PDMS), a chemical used in many domestic condom lubricant
preparations, was (not) detected. %
2. Complicated or unusual cases involving additional absorption p be difficult to write.

The template reports are a place to start and many valuable insi can be gained by reading
previous reports covering similar cases. It is a good idea e@ach analyst to maintain a file
of his or her complicated reports for future reference.

For cases involving mixtures: (b

Additional peaks were present in the sam;% MS may be a component of this mixture.

For cases involving identifiable orgagic &mpounds:

preparations, was (not) dete owever, another chemical compound(s) was detected
which is consistent with mical name here). Confirmation of this compound cannot
be completed at this timg)

Polydimethylsiloxane (PDME),\?lemical used in many domestic condom lubricant
For cases invalvi@dem{ﬁabie organic compounds:

Polydimethy: ane (PDMS), a chemical used in many domestic condom lubricant
preparations, Wwas (not) detected. However, another chemical compound(s) was detected

which cannot be identified at this time.

3. Qualitative statements may be part of the summary. They are used for probative samples
when:

a The sample is apparently unmixed.

b. The sample could be a mixture of two or more components, including PDMS.
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12A.

12B.

14

I5.

The three body cavity swabs (oral, vaginal/penile, and anal) are used to collect possible
biological fluids from those areas; the smears are used for a sperm search. The body cavity swabs
and/or dried secretions swabs may also be tested for the presence of condom lubricants.

Testing of body cavity swabs (oral, vaginal/penile, and anal):

Visually check the swabs for the presence of biological fluids. If the swabs are reddish brown in
color, be sure to test with KM reagent; note results. The slides accompanying the body cavity
swabs are stained using the Christmas Tree staining procedure (refer to Christmas Tree Stain for
Spermatozoa in the Forensic Biochemistry Methods Manual, version 4.0) and examined briefly for
the presence of sperm,; this search need not be exhaustive and should take no longer than five
minutes. A new Criminalist must have the sperm search witnessed for a period of six months and
the reviewing Criminalist must add their initials and date to the kit inventory form.

extraction. The analyst at this point should be sure to make an addit; tting from the vaginal
or penile swab to submit for amylase testing (be sure to always tg ile swabs as an external
area or “stain” for the purposes of P30 and/or amylase interprﬁ’ s).

If sperm is found on a slide, a cutting from the accompanying swab_}éj%;o directly for DNA

If no sperm is found on a slide, submit a cutting from on ch of the sperm (-) body cavity
swabs for P30 confirmatory testing. Again, the pertin abs (vaginal/penile and dried
secretions) will all automatically be tested for the frbnce of amylase by the P30 ELISA rotation

upon completion of the P30 testing.

If the swabs are semen and amylase negat ere is no need to retain the swabs, even if KM+

Upon completion of P30 testing, ix@ results (refer to the Biochemistry Methods Manual) to
determine further steps to take. \Nf séwen positive, make a second cutting from each P30 positive
swab for DNA testing. @

If semen negative but art positive, check to see if the case has a named suspect. If so, again,
make a second cutti }@n one swab from each designated bedy cavity area that is amylase
positive. Submit tai\ghtting to one-step Y STR typing. If the case has no named suspect, retain
the amylase po\iDme®items(s) for further testing if deemed necessary. See testing of dried
secretions swabe above for the treatment of amylase positive dried secretions swabs.

If the vaginal swabs are semen negative, submit a cutting for FTIR analysis for the presence of
condom lubricants. Testing of any other items for the presence of condom lubricants will be at

the discretion of the interpreting analyst.

The control envelope is a concept left over from the days of ABO testing. There is no need to
examine the contents.

The questionnaire, body diagram sheets, and instruction sheets are intended for the use of the
medical personnel. If present, make a copy of the questionnaire and/or body diagram sheets for
the left side of the case file; leave all originals in the kit. No item number is assigned if present.

Photographs and/or other paperwork are not supposed to be included in a kit. If present, make a
note of it; leave them in the kit. No item number is assigned if present.
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16.

17.

18.

Once all serology testing is completed on a kit, it should be promptly dealt with. Perform
additional cutting and retaining of kit items all at once for time efficiency. Additionally, return the
sexual assault kit to the Evidence Unit personnel. These tasks should be done within seven days
of the date of testing for the last P30/amylase results that are obtained. Promptly type up finalized

report.

If the kit is negative for semen, and there is no other evidence to examine, the case is finished and
the report may be written.

If the kit is negative for semen, and there is other evidence to examine (see Scheduled Analysis),
the case file must be replaced in the “to be examined” stack based on the P30 target date. See the
evidence exam supervisor to ensure this gets done properly. The FB number is added to the
“evidence to be assigned” sheet; the evidence sign-in supervisor modifies Paradox to reflect the
change in the status of the case.

If the kit is positive for semen, and was examined by a Crim I, it nee e transferred to an
interpreting analyst (this process is not necessary if the kit was exaghjfipd by a Crim II or higher;
that criminalist will keep the case file for DNA testing and integgdgttions). Contact the next Crim
IV on the Kit Transfer Worksheet to determine who will be&signed IA for the file. Fill this
information in on the “to be assigned” sheet. 7his needs one prior to submission to Chelex

so the assigned Criminalist 11, I1I, or IV will receive ent paperwork. Upon the additional
cutting, retaining and returning of the sexual assauyffjt, 1t is at this time the Criminalist I should
make a cutting of the victim’s exemplar to sub esting for DNA comparisons to any
P30/amylase positive swabs submitted for D ing.

The person who examined a kit is resp (Lfor returning the kit. It should be promptly
returned to the Evidence Unit (vo klt) or transferred to retained storage (post mortem
kits) upon completion of P30/a & esting. There is no need to wait for completion of DNA
testing to return a kit. 8

separated out and pla an accommodating manila envelope. Ensure that the envelope is
labeled with the agpkopriate identifying case information for the purpose of easy identification in
retained stora below as a guide for which items should be retained:

Prior to the return of a ?;’&&:ered kit to the Evidence Unit, the items to be retained must be

any P30/sperm positive swabs and slides

any amylase positive swabs

any semen positive stains from underwear or other clothing items

substrate controls if applicable

exemplar from victim - e.g., buccal sample, dried blood control, saliva sample
(semen-free oral swab or semen-free/amylase-free vaginal swab as a last resort)

For post-mortem kits, all used envelopes containing post mortem items are retained; the kit box
and any unused envelopes are discarded.

Retained items may remain in the possession of the interpreting analyst during any further
testing. Once testing is complete, they must be properly sealed and transferred to retained
storage.
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